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Online Conventions
This topic presents convention information that pertains to the 3D IMPACT! Online Information System. Therefore, information 
about how to use the standard Windows Help System (such as markers, browsing, searching, etc.) is not presented. If you need 
information about using the Windows Help System commands and options, choose the 3D IMPACT! HELP>How to Use Help 
command.

The 3D IMPACT! Online Information System provides a full reference resource for the software, rather than simply a help file. It 
is intended to be the primary source of information for 3D IMPACT! users. 

The Information System provides context-sensitive help from any point in 3D IMPACT!. Also provided are multiple entry points 
from the Information System's contents page (by command, by task, by screen, or by dialog). All of the Information System's 
sections are interconnected via hypertext and hypergraphic links, which you can use to quickly navigate to the information you 
need.

· The Information System provides the following:
Basic information about 3D IMPACT! (this section also includes basic information about 2D and 3D modeling, rendering, and 
animation)
3D IMPACT! Command Reference Guide
Index (search keywords)

· The following conventions are used in the 3D IMPACT! Online Information System:
Text Conventions
Buttons on the keyboard appear in angle brackets. For example "press the <Enter> key" or "press <Enter>."
Buttons in 3D IMPACT! dialog boxes appear in vertical brackets. For example, "click the [OK] button" or "click [OK]."
Menu commands are written in top-down order, with the main menu name in capital letters, followed by a ">" symbol and the 
command name. For example, "choose the EDIT>Bevel command."

Icon Conventions

The note icon  indicates that you can click on the icon to display additional related information.



What is Modeling?
Modeling is the process of using various tools to create a three-dimensional scene. When you use 3D IMPACT!, you become the
director and the scene becomes your set.

· Set Building
In 3D IMPACT!, the set is built by defining the background on which the scene will be displayed. You can use a background as 
simple as a defined color, or import a picture or photo. 

· Casting
The Tool Palette's text tool, along with the objects from the object catalog, are used to create two- and three-dimensional objects. 
The text you create and the objects you import are the actors.

· Wardrobe
You control the appearance of your actors by changing their appearance attributes (wardrobe). An object's appearance is 
determined by specifying its appearance attributes, such as material type and color.

· Directing
Once the set is built and the cast assembled, the cast-members are directed by using the Tool Palette's object manipulation tools 
to position each of the actors within the scene. When creating an animation in 3D IMPACT!, each object is positioned where it will 
end up after it has moved through its animation path.

Once the scene is modeled, it can be saved to disk as a project.

See Also:
What is Rendering? 
What is Animation? 



What is Animation?
Traditional Animation
In traditional animation, objects are animated by drawing a series of pictures, with each object changing position or shape slightly
from frame to frame. When viewing all the pictures in quick succession, the objects appear to move smoothly. 

For example, to create a one-second animation of 3D text zooming and spinning into the center of a scene, 30 to 60 individual 
drawings would have to be created, each showing the progression of the word zooming and spinning to its final position.

3D IMPACT! Animation
With 3D IMPACT!, objects are animated by assigning pre-defined animation paths that have been developed by professional 
animators. Keyframes are generated automatically by the software. So the user simply places the objects in their final positions 
and assigns motions. 

In the above example, the 3D text would be positioned at its final position, then a pre-defined zoom and spin motion path would 
be assigned to the 3D text. 

When the animation is rendered, 3D IMPACT! automatically generates the key frames and each interim frame. 

See Also:
What is Modeling? 
What is Rendering? 



What is Rendering?
After modeling a scene, it is rendered to create a picture. 

Rendering a 3D scene can take a lot of computing power, therefore, it is recommended that your computer is equipped with 
adequate memory (RAM) to facilitate the rendering task. 3D IMPACT! runs on a minimum of 16 MB RAM. However, if you are 
creating 3D scenes that involve various materials and objects, more RAM is recommended. 3D IMPACT! renders the picture in 
horizontal strips starting from the bottom of the screen. After each strip is calculated, it is displayed. 

When a scene is rendered, the computer calculates the color, shading, and mapping (both reflection and texture) for each object 
in the scene. Images rendered with 3D IMPACT! have a smoothly shaded, almost photo-realistic quality. And because Render 
applies anti-aliasing (called blended edges in 3D IMPACT!), objects have clean, sharp edges.

See Also:
What is Modeling? 
What is Animation? 
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    TOOLBAR 
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TOOLBAR

    Create a New Model     Open a Model 

    Save the Model     Undo 

    Group the Selection     UnGroup the Selection 

    Set Background     Bevel 

    Apply Material     Color 

    Render     Assign Motion 

    Preview Animation     Make Movie 

    Search For Help On 

Create a New Model
The FILE>New command clears the screen and creates a new untitled project file. 
If you choose New    when a project file is already open, you will be given the option to save the existing project file before it is 
replaced with the new project file.



Open a Model
The FILE>Open command loads a previously saved project (*.3di, *.scr, or *.mdl) file from disk into 3D IMPACT!
If you choose Open when there is already a project file open, you are given the option of saving the current project file before it is
replaced with the file you are opening.

See Also:
FILE>Recent File Command 



Save the Model
The FILE>Save command stores the current project file to disk. The project file is saved under its current name, unless it is a 
new "untitled" file. If the current project file is an untitled file, the save command functions like the FILE>Save As... command. 
When you save a project file, all the appearance and motion attributes (i.e., material, color, mapping, zoom in, etc.) are saved 
with the file. The file extension for a 3D IMPACT! project is "3di".

See Also:
FILE>Save As Command 



Group the Selection
The Edit>Group command combines any number of individual objects into a group. You can also use this command to combine 
groups with other groups or objects to create a new group known as a supergroup. 

Grouping objects can help speed up modeling and animation by allowing you to manipulate more than one object at a time while 
maintaining the individual group members' relative positions. You can also use appearance attribute and beveling commands to 
change the appearance of all objects in a group at one time.

3D IMPACT! classifies the hierarchy of groups as follows:

· Supergroups are the highest level in the hierarchy and contain at least two groups or at least one group and one individual 
object.

· Subgroups contain objects or groups and are members of a supergroup or another subgroup.
· Groups contain two or more objects.
· Objects are at the bottom of the hierarchy and can be members of a group, subgroup, or supergroup.
· If the selection you are grouping contains an object that is already a member of another group, the object is removed from its 

original group and is added to the new group.

See Also:
EDIT>UnGroup Command 



Ungroup the Selection
The EDIT>UnGroup command dissolves any selected groups. Ungrouping a supergroup only dissolves the highest level group; 
subgroups within the dissolved supergroup will maintain their individual groupings.

See Also:
EDIT>Group Command 



Bevel
The OBJECT>Apply Bevel command increases the depth of the polygons in the current selection by adding an angled or curved 
edge to each polygon. Primarily, beveling is used to turn 2D polygons (such as text) into 3D objects.

The Bevel dialog box provides a number of pre-defined bevels. To the right of the bevel buttons is a preview window that shows 
how the bevel will appear on the selected item. If a group of items is selected, only the first object in the group will show up in the
preview window.

The upper left-hand button is the "extrude" button. Selecting this "bevel" adds depth to the object by extruding the object straight 
back without applying a beveled edge to the front polygon. The remaining "bevels" apply a beveled edge to the front polygon in 
addition to increasing the depth of the object.

3D objects can not be beveled.



Color
The OBJECT>Assign Color command displays a standard Windows color selection dialog that lets you change the color of the 
selected object. The dialog lets you choose from the Windows standard color set, or you can create and store your own custom 
color.



TOOL PALETTE

    Selection Tool     Stretch Tool 

    Rotate Tool     Text Tool 

Selection Tool
The Selection tool is a multipurpose tool that can select, move, scale, and delete objects. Whenever you want to perform a task 
on an object (such as moving, scaling, coloring, animating, etc.), you must first use this tool to select the object.

When an object or group is selected, the four corners of an invisible bounding box are displayed. The following selections are 
available:

· Standard Selecting: Click on the object you want to select.

· Marquee Selecting: Click and drag out a marquee to enclose all the objects you want to select.

· Ambiguous Selecting: When you try to select one of several objects that overlap, the selection tool automatically functions in 
ambiguous selection mode. Clicking repeatedly when the selection tool is in ambiguous selection mode selects each 
overlapping object, one-at-a-time, in the order they were created.

· Adding/Removing Objects: You can modify all of the above selection methods to add and/or remove objects to/from the 
current selection. To do this, hold the <Shift> key while using one of the selection techniques. If you use the shift modifier on a
selected object it is removed from the selection. If you use it on an unselected object the object is added to the current 
selection.

· Group Member Selecting: You can modify all of the above selection methods to select only individual objects that are 
members of a group. To do this, hold the <Alt> key while using the techniques above to make the selection.

· Deselecting Objects: You can deselect the current selection by clicking anywhere outside of the selection

· Moving Objects: You can move any selection interactively by clicking within the selection and dragging it to the desired 
location. While you are moving a selection, the status bar displays the cursor's X, Y, and Z coordinates. When you move the 
cursor over a selection, it changes to a cross hair, indicating that the object can be moved.

· Scaling Objects: You can scale any selection interactively by clicking and dragging any of the selection's bounding box 
corners. While you are scaling a selection, the status bar displays the percentage you are scaling the selection. When you 
move the cursor over one of the selection's bounding box corners, it changes to a diagonal cross hair, indicating that the 
object can be scaled.

· Deleting Objects: You can delete the current selection by pressing the <Delete> key.



Stretch Tool
The Stretch tool resizes an object by stretching it on any one of its axes. You can stretch (as well as compress) an object along 
its X, Y, or Z-axis.

Unlike scaling, stretching distorts the proportions of an object. The amount you have stretched the selection (in percent) is 
displayed in the lower-right corner of the status bar.

If you are stretching a group, the stretch is performed from the edge of the group along the selected axis. 

 



Rotate Tool
The Rotate tool rotates an object around its X, Y, or Z-axis. You control the degree and direction of rotation interactively by 
moving the cursor..

In the rotation mode, X, Y, and Z-axis handles appear on the selected object. Clicking and holding on one of the handles selects 
that axis as the axis of rotation. 

To rotate an object in the positive direction, click and hold on one of the axis handles then move the cursor horizontally toward 
the right side of the screen. The amount you have rotated the selection (in degrees) is displayed in the lower-right corner of the 
status bar.

To rotate in the negative (opposite) direction, move the cursor horizontally toward the left side of the screen.

For example, to rotate an object as if it were rolling toward you, rotate it in the positive direction on its X-axis. To rotate the front 
of an object toward the right, rotate it in the positive direction on its Y-axis. To rotate an object clockwise, rotate it in the positive 
direction on its Z-axis.

 



Text Tool
The Text tool lets you create text objects by typing letters, other keyboard characters, and ASCII characters.

· Editing Text
The <Space bar>, <Backspace>, and <Enter> keys work as they would in a word processor. For example, to correct a typo, 
backspace until it is erased, then type the word correctly. The <Enter> key functions as a carriage return, moving the cursor down 
one line.

· Completing a Text Entry
To finish entering text, do one of the following: press the <Esc> key; click elsewhere in the scene to begin a new text group; or 
choose another tool. Once you finish entering text, the letters you typed are converted to objects and can no longer be edited as 
text. However, you can always modify text objects using the object editing tools. For example, you can no longer change the spelling
of a word after pressing the <Esc> key, but you can move, stretch, bevel, etc., the letters.

· Text Grouping
In 3D IMPACT!, the text you create consists of individual letter objects that are automatically grouped together when you finish 
entering a text field. Because each letter is a separate object, you have the option of modifying the letter objects (e.g. beveling, 
changing color, mapping, animating, etc.) as a group, or as individual letters. Like any other group, text groups can be ungrouped. 
For example, you could apply one animation motion to the text group and additionally, a different motion to each letter in the text 
group. This would create a compound motion.

· Changing Font Style and Size
Before you complete a text entry (by pressing <Esc>, etc.), you can change the font style, point size, and text attributes (bold, italic) 
of the text you are creating by using the controls provided in the Text Ribbon, which appears just below the toolbar. Any changes 
you make take effect immediately, so all letters in the text group are affected. The current Text Ribbon settings remain in effect until 
you either change them again or restart the program.

· For True Type fonts, you can access the entire extended ASCII character and symbol sets.



FILE MENU

    New     Open 

    Save     Save As 

    Import 2D Objects     Show Image 

    Save Image     Exit 

    Recent Files 

New
The FILE>New command clears the screen and creates a new untitled project file. If you choose New when a project file is 
already open, you will be given the option to save the existing project file before it is replaced with the new project file.



Open
The FILE>Open command loads a previously saved project (3DI, SCR, or MDL) file from disk into 3D IMPACT!

If you choose Open when there is already a project file open, you will be given the option to save the current project file before it 
is replaced with the file you are opening.

See Also:
FILE>Recent File command 



Save
The FILE>Save command stores the current project file to disk. The project file is saved under its current name, unless it is a 
new "untitled" file. If the current project file is an untitled file, the save command functions like the FILE>Save As... command. 
When you save a project file, all the appearance and motion attributes (i.e., material, color, mapping, zoom in, etc.) are saved 
with the file. The file extension for a 3D IMPACT! project is "3di".

See Also:
FILE>Save As command 



Save As
The FILE>Save As command stores the current project file to disk with the name you specify. When you save a project file, all 
the appearance and motion attributes (i.e., material, color, mapping, zoom in, etc.) are saved with the file. The file extension for a
3D IMPACT! project is "3di".

See Also:
FILE>Save Command 



Import 2D Objects
The FILE>Import 2D Objects command loads a 2D line art drawing (such as those created in Adobe Illustrator and CorelDRAW) 
into the current project file as polygonal objects.

The objects created when you import a file appear in the center of the frame and are automatically selected.



Show Image
The FILE>Show Image command displays an image file that is stored on disk. This command can show images that are stored 
in the following image file formats:

JPEG File Interchange Format (*.jpg, *.jpeg)
Portable Network Graphics (*.png)
Windows bitmap (*.bmp, *.dib, *.rle)
GIF (*.gif)
PC Paintbrush (*.pcx)
Targa (*.tga)
Tagged Image File Format (*.tif)

Images are displayed at their full size if they will fit on the screen. Otherwise, the image is scaled down (in 50 percent 
increments) until it fits in the screen. The Show Image display window provides zoom controls and, if necessary, scroll bars. The 
Show Image display window also provides information about the image resolution, zoom factor, color-bit depth, and file size.



Save Image
The FILE>Save Image command displays a dialog that lets you specify how you want to save the current image. The dialog 
provides you with the following controls/options:

· Image name and location

· Image type:
JPEG File Interchange Format (*.jpg, *.jpeg),
Portable Network Graphics (*.png), 
Windows bitmap (*.bmp, *.dib, *.rle), 
GIF (*.gif), 
PC Paintbrush (*.pcx), 
Targa (*.tga), 
Tagged Image File Format (*.tif)

· Options:
The image options available depend on the image type you choose. Click on the Options... button to see the available options
for each image type.

· Image format:
The image formats available depend on the image type you choose. Use the dialog's scroll list to see all of the available 
options.

· Image resolution:
You can set the image dimensions in pixels (X & Y). 



Exit
The FILE>Exit command shuts down 3D IMPACT! and returns you to the Windows program manager. When you choose Exit, 
you will be given the option to save the current project file. If you do not save the project file, you will lose any changes you have 
made since the last time the file was saved.



Recent Files
The FILE>Recent Files command displays a list containing the names of the last four project files opened. Clicking on its name 
in the list can open any one of these files.

See Also:
FILE>Open Command 



EDIT MENU

    Undo     Copy Screen 

    Clear     Remove Rotation 

    Group     UnGroup 

    Select All 

Undo
The EDIT>Undo command reverses the last edit you performed.

The menu text changes to Redo once you have undone something. Choosing Redo restores the last edit that was undone. The 
button will continue to toggle between Undo and Redo for the last edit until another undoable edit is performed.

Not all commands can be undone. Generally, file commands cannot be undone. Also excluded are commands that do not 
change the model in any way, such as the render command.



Copy Screen
The EDIT>Copy Screen command allows you to copy the current screen to the clipboard for pasting into another application 
such as MS Word, PowerPoint, Photoshop, etc. 



Clear
The EDIT>Clear command deletes the current selection from the project file.



Remove Rotation
The EDIT>Remove Rotation command allows you to clear all rotations applied to the selected object, resetting the orientation of 
the previously rotated object so that the face of the front polygon of the object is parallel with the screen. 



Group
The Edit>Group command combines any number of individual objects into a group. You can also use this command to combine 
groups with other groups or objects to create a new group known as a supergroup. 

Grouping objects can help speed up modeling and animation by allowing you to manipulate more than one object at a time while 
maintaining the individual group members' relative positions. You can also use appearance attribute and beveling commands to 
change the appearance of all objects in a group at one time.

3D IMPACT! classifies the hierarchy of groups as follows:

· Supergroups are the highest level in the hierarchy and contain at least two groups or at least one group and one individual 
object.

· Subgroups contain objects or groups and are members of a supergroup or another subgroup.
· Groups contain two or more objects.
· Objects are at the bottom of the hierarchy and can be members of a group, subgroup, or supergroup.
· If the selection you are grouping contains an object that is already a member of another group, the object is removed from its 

original group and is added to the new group.

See Also:
EDIT>UnGroup Command 



UnGroup
The EDIT>UnGroup command dissolves any selected groups. Ungrouping a supergroup only dissolves the highest level group; 
subgroups within the dissolved supergroup will maintain their individual groupings.

See Also:
EDIT>Group Command 



Select All
The EDIT>Select All command selects everything in the project file.

See Also:
EDIT>Select Command 
Selection Tool 



VIEW MENU

    Toolbar     Tool Palette 

    Text Ribbon     Justification Bar 

    Status Bar     Object Catalog 

    Preview Options... 

Toolbar 
The VIEW>Toolbar command toggles on and off the display of the toolbar that appears under the menu. The toolbar has buttons 
that provide you with quick access to commonly used commands.



Tool Palette 
The VIEW>Tool Palette command toggles on and off the display of the tool palette that appears along the left edge of the 
window. The tool palette buttons provide the tools you will use to create and edit objects.



Text Ribbon
The VIEW>Text Ribbon command toggles on and off the display of the text ribbon, which appears below the toolbar. The text 
ribbon provides drop-down lists that let you choose the font style and point size for the text tool. The text ribbon also provides 
two buttons that let you toggle on and off the bold and italic style attributes.



Justification Bar
The VIEW>Justification Bar command toggles on and off the display of the justification bar that appears to the right of the text 
ribbon. The justification bar provides three buttons that allow you to justify your objects, left, right, or horizontal center, relative to 
the work area.



Status Bar
The VIEW>Status Bar command toggles on and off the display of the status bar that appears at the bottom of the screen. The 
status bar provides text that identifies the buttons on the tool palette, and it displays brief hints for using the currently selected 
tool or command. The status bar also displays the cursor's current coordinates, or numeric feedback from the tool you are 
currently using.



Object Catalog
The VIEW>Object Catalog command toggles on and off the display of the object catalog that appears below the Working Area 
and above the status bar. The object catalog displays a number of 3D objects that can be dragged into the Working Area of 3D 
IMPACT!



Preview Options...
The VIEW>Preview Options... command opens a dialog box which allows you to choose to work in either wireframe or shaded 
mode. It also gives additional options for shaded mode. The preview options dialog box shows the type of shading software 
being used and indicates whether or not your hardware acceleration is turned on.



OBJECT MENU

    Apply Bevel     Apply Material 

    Assign Color     Duplicate 

    Mirror     Properties 

Apply Bevel
The OBJECT>Apply Bevel command increases the depth of the polygons in the current selection by adding an angled or curved 
edge to each polygon. Primarily, beveling is used to turn 2D polygons (such as text) into 3D objects.

The Bevel dialog box provides a number of pre-defined bevels. To the right of the bevel buttons is a preview window that shows 
how the bevel will appear on the selected item. If a group of items is selected, only the first object in the group will show up in the
preview window.

The upper left-hand button is the "extrude" button. Selecting this "bevel" adds depth to the object by extruding the object straight 
back without applying a beveled edge to the front polygon. The remaining "bevels" apply a beveled edge to the front polygon in 
addition to increasing the depth of the object.

3D objects can not be beveled.



Apply Material
The OBJECT>Apply Material command assigns surface characteristics to the current selection.

The Apply Material dialog box provides 12 predefined materials that are arranged around a central preview window. If more than 
one object is selected, only the first object in the group will appear in the preview window.



Assign Color
The OBJECT>Assign Color command displays a standard Windows color selection dialog that lets you change the color of the 
selected object. The dialog lets you choose from the Windows standard color set, or you can create and store your own custom 
color.



Duplicate
The OBJECT>Duplicate command makes an exact copy of the current selection. 

For example, if you were building a background of repeating logos, you would simply create or import one, then duplicate it as 
necessary. Each duplicate can then be modified as needed.

See Also:
OBJECT>Mirror Command 



Mirror
The OBJECT>Mirror command makes a mirror-image copy of the current selection. The mirrored copy appears below the 
original selection. Objects created with the Mirror command have the same material attributes as the original objects. The Mirror 
command works well for creating reflection or shadow effects with text or other objects.

See Also:
OBJECT>Duplicate Command 



Properties
The OBJECT>Properties command displays the name of a selected object/group, the memory usage, and the number of images
applied. It also shows information regarding the number of polygons and vertices in the selected item(s).



SCENE MENU

    Redraw     Render 

    Working Area     Set Background 

Redraw
The RENDER>Redraw command redraws your current screen according to the shading mode previously selected under 
VIEW>Preview Options, in either wireframe or shaded mode.



Render
The RENDER>Render command renders the project with photorealistic detail. Render calculates the shading of every polygon, 
and all objects are smoothly shaded. Highlights, maps (texture and reflection), material attributes, and the entire project's other 
appearance attributes are displayed.



Working Area
The RENDER>Working Area command displays a dialog that allows you to specify the dimensions, in pixels, of the Working 
Area. Objects positioned outside of the Working Area will not show up in the final render (neither still nor animation).

You can choose from several standard sizes or you can specify a custom width and height. 



Set Background
The RENDER>Set Background command displays a dialog that lets you specify the background of the scene. You can choose 
between two background types: Color or Image. The image file types available for the background include the following:

JPEG File Interchange Format (*.jpg, *.jpeg),
Portable Network Graphics (*.png), 
Windows bitmap (*.bmp, *.dib, *.rle), 
GIF (*.gif), 
PC Paintbrush (*.pcx), 
Targa (*.tga), 
Tagged Image File Format (*.tif)
AVI Movie (*.avi)
Targa Sequence (*.tga)

You also have the option of setting the image to be scaled or tiled to the Working Area.
Having the right color or image as a background can add the finishing touch to any project. However, an image background 
causes slower rendering while modeling.

See Also:
Creating an Animated Background 



ANIMATION MENU

    Assign Motion     Delete Motion 

    Delete Animation     Show/Hide Paths 

    Preview Animation     Make Movie 

Assign Motion
The ANIMATION>Assign Motion command displays the Motions dialog box that lets you assign a predefined motion path to the 
current selection. 

The Assign Motion dialog box provides 12 predefined motions that are arranged around a central preview window. If more than 
one object is selected, the entire group will appear in the preview window. Please note that the speed of the motion is going to 
depend upon the hardware and OpenGL capabilities of your system, and upon the number of objects you have currently 
selected.

Before you assign a motion, you should place the objects in their final position. 3D IMPACT! will calculate the beginning position 
and interim positions for all objects that have a motion assigned to them.

See Also:
ANIMATION>Delete Motion Command 



Delete Motion
The ANIMATION>Delete Motion command deletes any motions assigned to the current selection. If a motion is deleted when 
motion paths are visible, you will see that its path is also deleted.

See Also:
ANIMATION>Delete Animation Command 
ANIMATION>Assign Motion Command 



Delete Animation
The ANIMATION>Delete Animation command deletes all motions from every object in the project. If you use this command when
motion paths are visible, you will see that all the motion paths are deleted. This command is not undoable, so you may want to 
save a copy of your project before you use this command.

See Also:
ANIMATION>Delete Motion Command 
ANIMATION>Assign Motion Command 



Show/Hide Paths
The ANIMATION>Show/Hide Paths command toggles the motion paths on or off for all objects or groups which have been 
assigned motions.

Motion paths are lines that indicate the path that a group or object will follow when animated. The motion path lines are color 
coded to their object or group.



Preview Animation
The ANIMATION>Preview Animation command uses OpenGL, a type of accelerated 3D rendering to generate a shaded version 
of your animation for real time playback on screen. Please note that the "real time" playback speed is dependent upon the 
complexity of your 3D animated scene (e.g. the more 3D and other objects in the scene, the more complex the animation), as 
well as your computer configuration such as available RAM, processor (CPU) speed, and whether or not there is 3D acceleration
hardware present (i.e., a 3D accelerated graphics board) that accelerates the rendering of OpenGL shading. 



Make Movie
The ANIMATION>Make Movie command lets you to render a movie to disk in the following file formats: Video For Windows 
(*.avi); Animated GIFs (*.gif); Autodesk Animation (*.flc); Targa Sequence (*.tga); Bitmap Sequence (*.bmp); and GIF Sequence 
(*.gif). Compressed digital movies (i.e., AVI, FLC, and Animated GIF) can then be played back using a Windows compatible 
graphics board. The Make Movie command is not available unless at least one motion has been assigned to an object in your 
project.

The Make Movie dialog provides the following options:

· Compression – Various compression options are available for movies rendered in the AVI format.

· Options -- The following options are available for the following formats:
Animated GIFs -- Transparent background and Blend edges (anti-aliasing) with current background.
Targa Sequence -- Field Rendering, Reverse fields (when field rendering is selected), and NTSC color correction.
Bitmap Sequence -- -- Field Rendering, Reverse fields (when field rendering is selected), and NTSC color correction.
GIF Sequence -- Transparent background and Blend edges (anti-aliasing) with current background.

· Format -- The number of colors used to make the movie. Color depth can be set to 8-bits (256 colors) in FLC format; up to 256 
colors in Animated GIF and GIF Sequence format, 8-bits or 24-bits in AVI or Bitmap Sequence format, and 32-bits in Targa 
Sequence format.

· X-Y Pixel Resolution -- The size of the movie in pixels. The X and Y screen resolution can be adjusted, however, a constant 
ratio is maintained, based upon the Working Area.

· Scene Length -- For AVI, Animated GIF and FLC formats, the number of seconds the movie will play. Maximum scene length is 
100 seconds. For all Sequence formats, the scene length is the total number of frames for the animation. The maximum scene 
length is 1,000 frames.

· Pause -- The number of seconds the animation's last frame is displayed after the movie ends. Maximum pause length is 100 
seconds for AVI, Animated GIF and FLC formats. The maximum pause length is 1,000 frames for all Sequence formats.

· Frame Rate -- For AVI, Animated GIF and FLC formats, the number of frames played per second. Frame Rate can be set from 
1-72 frames per seconds. For all Sequence formats, frame rate is not applicable, so is disabled.

· Range -- Allows you to render only a portion of the animation. The default is to render the entire animation. This is useful for 
reducing the size of your animation files, as well as for eliminating dead time.    For more information, see “Editing Animations”.

Once all options are set or defaults accepted, 3D IMPACT! renders the animation frame-by-frame. Compressed digital movies 
will then play back in the Make Movie window. For sequenced image files rendered using Make Movie (i.e., tga, bmp, gif), you 
may view individual frames of the animation using the FILE>Show Image command. However, for real time playback of these 
frames, you will need to compress them to a digital movie format or output the sequential frames through digital video playback 
hardware and/or output the sequential frames of animation onto video tape.

The movie is automatically saved to the file name and format specified when you click on the save button in the Make Movie 
window, after the movie is rendered.

See Also:
Editing Animations 



WEB LINKS MENU

    Free Stuff!     Product Registration 

    Tips & Tricks     User Community 

    How to Contact Us     Technical Support 

    Send Us Your 
Feedback 

    Upgrade Information 

    3D IMPACT! Home 
Page 

    CrystalGraphics Home 
Page 

Free Stuff!
The WEBLINKS>Free Stuff! command takes you to the Free Stuff! area on the CrystalGraphics website if you have a web 
browser installed on your system. If you do not have a web browser installed on your system, your pointer will return to the 
Working Area.

Come back frequently to download more FREE professional quality 3D objects for Crystal 3D IMPACT!



Product Registration/Purchase
The WEBLINKS>Product Registration command takes you to the Product Registration area on the CrystalGraphics website if 
you have a web browser installed on your system. If you do not have a web browser installed on your system, your pointer will 
return to the Working Area.

The WEBLINKS>Product Purchase command takes you to the Product Purchase area on the CrystalGraphics website if you 
have a web browser installed on your system. If you do not have a web browser installed on your system, your pointer will return 
to the Working Area.

Register your product to receive many benefits exclusively for registered users. 

 



Tips & Tricks
The WEBLINKS>Tips & Tricks command takes you to the 3D IMPACT! Tips & Tricks area on the CrystalGraphics website if you 
have a web browser installed on your system. If you do not have a web browser installed on your system, your pointer will return 
to the Working Area.

Helpful hints so you’ll get the most out of your software.



User Community
The WEBLINKS>User Community command takes you to the User Community area on the CrystalGraphics website if you have 
a web browser installed on your system. If you do not have a web browser installed on your system, your pointer will return to the
Working Area.

Exchange ideas with other Crystal 3D IMPACT! users.



How to Contact Us
The WEBLINKS>How to Contact Us command takes you to the Contact Us area on the CrystalGraphics website if you have a 
web browser installed on your system. If you do not have a web browser installed on your system, your pointer will return to the 
Working Area.

A listing of e-mail addresses; phone and fax numbers.



Technical Support
The WEBLINKS>Technical Support command takes you to the 3D IMPACT! Technical Support area on the CrystalGraphics 
website if you have a web browser installed on your system. If you do not have a web browser installed on your system, your 
pointer will return to the Working Area.

A listing of common problems and their solutions.



Send Us Your Feedback
The WEBLINKS>Send Us Your Feedback command takes you to the Send Us Your Feedback area on the CrystalGraphics 
website if you have a web browser installed on your system. If you do not have a web browser installed on your system, your 
pointer will return to the Working Area.

Send us your comments and requests for future versions of Crystal 3D IMPACT!



Upgrade Information
The WEBLINKS>Upgrade Information command takes you to the 3D IMPACT! Upgrade Information area on the CrystalGraphics
website if you have a web browser installed on your system. If you do not have a web browser installed on your system, your 
pointer will return to the Working Area.

Feature and availability information about the more powerful Crystal 3D IMPACT! Pro.



3D IMPACT! Home Page
The WEBLINKS>3D IMPACT! Home Page command takes you to the 3D IMPACT! Home Page area on the CrystalGraphics 
website if you have a web browser installed on your system. If you do not have a web browser installed on your system, your 
pointer will return to the Working Area.

Keep updated on Crystal 3D IMPACT! by visiting its home page often.



CrystalGraphics Home Page
The WEBLINKS>CrystalGraphics Home Page command takes you to the CrystalGraphics Home Page area on the 
CrystalGraphics website if you have a web browser installed on your system. The address for the CrystalGraphics home page is 
www.crystalgraphics.com. If you do not have a web browser installed on your system, your pointer will return to the Working 
Area.

See all the new things happening at www.crystalgraphics.com.



HELP MENU

    Contents     Search for Help On 

    How to Use Help     How to Register/Purchase 

    How to Obtain Technical Support     About 3D IMPACT! 

Contents
The HELP>Contents command displays the 3D IMPACT! on-line documentation system's contents screen. From this screen you
can access any portion of the on-line help system.



Search for Help on
The HELP>Search for Help on... command performs a keyword search throughout the help system and provides a list of help 
topics that match your search criteria.



How to use Help
The HELP>How to use Help command displays the standard instructions for using the Windows help engine.



How to Register/Purchase
The HELP>How to Register command displays instructions for how to register your product with CrystalGraphics.

The HELP>How to Purchase command displays instructions for how to purchase your product from CrystalGraphics.



How to Obtain Technical Support
The Help>How to Obtain Technical Support command displays a dialog box that shows the phone and fax numbers and email 
address for contacting Technical Support at CrystalGraphics as well as the hours of operation.



About 3D IMPACT!
The HELP>About 3D IMPACT! command displays an about box that shows the software revision number, the serial number, and
the copyright notice.



Note icon

The note icon indicates that you can click on the icon to display additional related information.



Hint:

Holding down the <Shift> key while dragging the cursor will cause the stretch to occur from the center of the group.



COMMANDS

    File Menu     Edit Menu 

    View Menu     Object Menu 

    Scene Menu     Animation Menu 

    Web Links Menu     Help Menu 

Product Purchase

If you are purchasing The Product, it will automatically be registered with CrystalGraphics.



Rotate Hint:

Holding the <Shift> key while dragging the cursor will constrain the rotation to 45-degree increments.



To Keep File Sizes Small
Animate icons and logos rather than full 3D text (file size stays smaller when your 3D text remains stationary).

Keep the file resolution, frame rate and colors to a minimum.



To Create Nice Effects
Set your Working Area to a planned resolution before you start.

Use rotating motions rather than fly-in motions (fly-in motions are best for full-screen animations such as the type used for video 
tape output).

Load in an image that approximates the background over which you plan to display your images and animations. Then render 
your image or animation making sure to set your Save Image or Make Movie options to "Transparent Background" and "Blend 
Edges with Current Background".



For Best Output Results
Set Background to black to make your 3D artwork stand out more.

Use the highest quality compression option in the Make Movie dialog.

Avoid deep reds, since they do not tend to look very good in video formats.



Using a Background Image
3D artwork displayed over an appealing background image or texture gives the finished artwork a creative and professional look.
It’s easy to do using 3D IMPACT!. Just follow these steps:
1. Click on the Scene menu, and then select Set Background.
2. In the Set Background dialogue box, there are two options you can choose from: Color or Image. 
3. Click the radio button by the Image option. You can either type in the location of your picture file or click on the Browse button. 
(The Browse button will bring up a standard Windows browse dialogue.) Select a picture file that you would like to set as your 
background, then click on the Open button. The name of the selected picture file should appear in the box near the Browse 
button.
4. Within the Image dialogue, you can choose whether you want to scale or tile your picture file. If you would like your picture to 
be repeated across the background, then click the radio button by the Tile option. Otherwise, select the Scale option, which will 
scale your picture to fit the Working Area.
5. Once you have your background image set, the 3D artwork that you create will be superimposed over the background image, 
making it useful for checking creative balance and ideal placement right up to the final rendered image.



Using Web Backgrounds with 3D IMPACT!
1. When you plan to create 3D artwork to insert on a web page that has a background texture or image, you’ll want to have the 
background texture available to bring into 3D IMPACT!. If you do not have a saved copy of the background texture file, you can 
use your web browser tools to save a copy of it. Follow these steps to do this:

(a.)    Run your web browser software and go to the web page where you plan to add 3D artwork.
(b.)    Move the cursor to an area of the web page where the background image is displayed.
(c.)    Click the right mouse button; a menu of commands will display.
(d.)    Choose the Save as a Picture command. Save the background texture to a selected folder on your local hard drive (i.e. 
the 3D IMPACT! Pictures folder) as a GIF file, which is a common image file format used for web page graphics.

2. Load the 3D IMPACT! software. 
3. Click on the Scene menu, then select Set Background.
4. In the Set Background dialogue box, there are two options you can choose from: Color or Image. 
5. Click the button by the Image option. Load the image that is being used for a web page background. You can either type in the
location of the desired image file or click on the Browse button. (The Browse button will bring up a standard Windows browse 
dialogue.) 
6. Within the Image dialogue, you can choose whether you want to scale or tile your picture file. Choose the Tile option and click 
OK. 
7. Create your 3D text and/or logo over the background image. Don't forget that it is very important to save your work 
periodically! To save, click on the File menu and select Save. The first time you save, it will bring up a dialogue box that will allow
you to choose a name for your image and its location on your computer. Click Save after you are done. This will save the file in 
3D IMPACT! (.3di) format. 
8. Once you are satisfied with your work, you can render your artwork and save the image to disk. To save the image:

(a.)    Click on the File menu and select Save Image. The Save Image dialogue box will prompt you to enter an image 
filename. Type in a name for your file. 
(b.)    Click on the Select Folder button to choose the directory in which you would like to store your file (i.e. 3D IMPACT! 
Pictures folder). 
(c.)    Once you have completed steps a & b, click on the Save button. This will close the Select Folder dialogue and bring you
back to the Save Image dialogue box. 
(d.)    Next, select the picture file Type. Since you will be integrating your 3D IMPACT! artwork with a web page that already 
has a background image, you’ll want to save the image with a transparent background. For a transparent picture, click on the
triangle to the right of the blank box and select GIF (*.gif) from the options. 
(e.)    Click on the Options button and a dialogue box will display with three options:    Transparent Background, Blend edges 
with current background and Incremental Download. Click on all three of those options such that there is a check mark in the 
box in front of each option. Then click OK. (You don't need to be concerned about “Format” because there is only one format 
available for this option and it is automatically selected.)
(f.)    You’ll then set the resolution or size of the image that you are saving. The X value is the height of your image and the Y 
is the width. Remember that this size is in pixels. Type in the size you want for your image. (Please refer to    To Keep File 
Sizes Small    about how to keep file sizes small). Once you have set the output resolution , click OK. 

9. Once your image file is saved, exit 3D IMPACT! and use your preferred web authoring tool(s) to place your custom 3D image 
on your web page.



Using Web Backgrounds with 3D IMPACT! Animations
1. Follow steps #1 through #7 as described under    Using Web Backgrounds with 3D IMPACT!    for generating 3D text or a 3D 
logo image to integrate into a web page. 
2.    When you are ready to animate your 3D logo, select an object in your project (i.e. your logo), then click on the Animation 
menu and select Assign Motion. A dialogue box that displays 12 pre-defined motions will appear. Click on a motion that you want.
(A preview of the selected motion for that object will be played in the center window of the dialogue box.)    Once you are satisfied
with the selected motion(s), click the [OK] button. Please refer to    To Keep File Sizes Small to achieve optimal effects.
3. To generate an animation of your 3D IMPACT! artwork, you will create a movie as follows:

(a.)    Go to the Animation menu and select Make Movie. The Make Movie dialogue box will prompt you to enter a movie 
filename. Type in a name for your file. 
(b.)    Click on the Select Folder button to choose the directory in which you would like to store your movie file (i.e. 3D 
IMPACT! Movies folder). 
(c.)    Once you have completed steps a & b, click on the Save button. This will close the Select Folder dialogue and bring you
back to the Save Image dialogue box. 
(d.)    Next, select the picture file Type. Since you will be integrating your 3D IMPACT! movie with a web page that already has
a background image, you’ll want to save the image with a transparent background. For a transparent output file, click on the 
triangle to the right of the blank box and select GIF (*.gif) from the options. 
(e.)    Click on the Options button and a dialogue box will display with two options:    Transparent Background and Blend edges
with current background. Click on both of those options such that there is a check mark in the box in front of each option. 
Then click OK. (You don't need to be concerned about “Format” or “Color” options because there is only one format 
available for these options and they are automatically selected.)
(f.)    You’ll then set the resolution or size of the animated movie that you are saving. The X value is the height of your image 
and the Y is the width. Remember that this size is in pixels. Type in the size you want for your movie. (Please refer to the tips 
“For Web Users” about how to keep file sizes small).
(g.)    The Scene Length option allows you to enter a value for how long you want the animation to last. And the Pause option 
should be used if you want your movie to pause for a defined period of time at the end of one complete sequence. 
(h.)    Set the Frame Rate for the number of frames per second for the movie playback.
Once you have set the above output options, click OK. The Make Movie tool will create an animated GIF file and play it back 
on screen. You can then exit 3D IMPACT! and use your preferred web authoring tool(s) to place your custom 3D animated 
GIF movie in your web page.



TIPS & TRICKS

    For Web Users     For Video Users 

FOR WEB USERS

    Creating an Animated 
Background 

    Creating an Animated Texture 

    Editing Animations     Reducing File Size 

    Partial Animations     Animating Pictures 

    Range     Selecting the Correct Object 

    To Create Nice Effects     To Keep Animation File Size 
Small 

    To Keep File Sizes Small     To Use Custom Images on 
Object Templates 

    Using a Background Image     Using Web Backgrounds 

    Using Web Backgrounds with 
Animations 

For Video Users
Set Background to black to make your 3D artwork stand out more.

Use the highest quality compression option in the Make Movie dialog.

Avoid deep reds, since they do not tend to look very good in video formats.



Left Justify

This button justifies the current selection to the left-hand side of the Working Area.



Center Justify

This button justifies the current selection to the horizontal center of the Working Area.



Right Justify

This button justifies the current selection to the right-hand side of the Working Area.



Font Selection

Select the font style from the drop down list box.



Font Size

Select the font size from the drop down list box.



Bold Button

Click on this button to create bold text.



Italic Button

Click on this button to create italic text.



Working Area

Use the RENDER>Working Area command to specify the dimensions for your Working Area. Or, use the handles to change the 
dimensions when no object in the model is selected.



Zoom Control

The Zoom Control displays the current zoom factor for the Working Area. Select a zoom factor from the drop down list box. 
Selecting Fit to Window increases the zoom factor so that the Working Area fits the main window.



Object Catalog Window

The object catalog window contains a series of predefined objects that can be used in the software. To use them, simply click on 
the desired object and drag and drop it into the Working Area. The new object will then appear in the Working Area. Some of the 
objects have texture maps that can be replaced with your own images.

See Also:
To Use a Custom Image on Object Catalog Template Objects 
Creating an Animated Texture 
Animating Pictures 



To Use a Custom Image on Object Catalog Template Objects
To use a custom image on one of the template objects, follow the steps outlined below:

1) Click on the appropriate tab in the Object Catalog window to reveal the desired template object(s).
2) Drag the selected object into the Working Area. A Replace Image dialog box will automatically open.
3) Click on the Browse button. A standard Windows Open dialog will appear.
4) Select the desired custom image and click [OK]. 
5) Click [OK] in the Replace Image dialog.
6) Your custom image should appear on the object selected the next time you shade it or render it.

 
See Also:
Creating an Animated Texture 



Animating Pictures
If you have pictures you have digitized that are available to your computer, you can animate them in three-dimensions using this 
program. Simply select an appropriate object from the catalog, drag and drop it into your Working Area, and replace its texture 
map(s) with your picture (“image”) when prompted. 

See Also:
To Use a Custom Image on Object Catalog Template Objects 



Editing Animations
Files sizes are very important on the Web. To keep your animation file sizes down, there is a trick you can do in some cases. 
That is to render only a portion of your animation. Set your object on its edge, so it faces directly away from you. Assign a 
rotational motion (such as "Spin Left”). In Make Movie, use the “Range” option to indicate that you only want to render the first 
half or second half of your animation. Then select OK. Since the animation plays in a continuous loop, your model will appear to 
rotate constantly. But since you only rendered half of your animation, the file size gets cut in half!    And it only takes half as much
time to render. One other advantage of this technique is that you can set it up so your logo, or text, or picture is always front 
facing. After all, who wants to look at the back side of any of those things!    

The Range option is also useful for eliminating an unwanted portion of your animation, such as a fly in motion, where the object 
of interest lies outside of the Working Area for a period of time. 



To Keep Animation File Size Small
Files sizes are very important on the Web. To keep your animation file sizes down, there is a trick you can do in some cases. 
That is to render only a portion of your animation. Set your object on its edge, so it faces directly away from you. Assign a 
rotational motion (such as "Spin Left”). In Make Movie, use the “Range” option to indicate that you only want to render the first 
half or second half of your animation. Then select OK. Since the animation plays in a continuous loop, your model will appear to 
rotate constantly. But since you only rendered half of your animation, the file size gets cut in half!    And it only takes half as much
time to render. One other advantage of this technique is that you can set it up so your logo, or text, or picture is always front 
facing. After all, who wants to look at the back side of any of those things!    

The Range option is also useful for eliminating an unwanted portion of your animation, such as a fly in motion, where the object 
of interest lies outside of the Working Area for a period of time. 



Reducing File Size
Files sizes are very important on the Web. To keep your animation file sizes down, there is a trick you can do in some cases. 
That is to render only a portion of your animation. Set your object on its edge, so it faces directly away from you. Assign a 
rotational motion (such as "Spin Left”). In Make Movie, use the “Range” option to indicate that you only want to render the first 
half or second half of your animation. Then select OK. Since the animation plays in a continuous loop, your model will appear to 
rotate constantly. But since you only rendered half of your animation, the file size gets cut in half!    And it only takes half as much
time to render. One other advantage of this technique is that you can set it up so your logo, or text, or picture is always front 
facing. After all, who wants to look at the back side of any of those things!    

The Range option is also useful for eliminating an unwanted portion of your animation, such as a fly in motion, where the object 
of interest lies outside of the Working Area for a period of time. 



Partial Animations
Files sizes are very important on the Web. To keep your animation file sizes down, there is a trick you can do in some cases. 
That is to render only a portion of your animation. Set your object on its edge, so it faces directly away from you. Assign a 
rotational motion (such as "Spin Left”). In Make Movie, use the “Range” option to indicate that you only want to render the first 
half or second half of your animation. Then select OK. Since the animation plays in a continuous loop, your model will appear to 
rotate constantly. But since you only rendered half of your animation, the file size gets cut in half!    And it only takes half as much
time to render. One other advantage of this technique is that you can set it up so your logo, or text, or picture is always front 
facing. After all, who wants to look at the back side of any of those things!    

The Range option is also useful for eliminating an unwanted portion of your animation, such as a fly in motion, where the object 
of interest lies outside of the Working Area for a period of time. 



Range
Allows you to render only a portion of the animation. The default is to render the entire animation. This is useful for reducing the 
size of your animation files, as well as for eliminating dead time.    

See Also:
Editing Animations 



Locate
Selecting the Locate button in the Object Catalog dialog allows a new Catalog folder to be chosen. A Browse for Folder dialog 
box opens when the Locate button is clicked upon. Click on the new Catalog folder and then on the [OK] button. A tab will be 
assigned to each folder within the Catalog folder. Thumbnails of the objects contained in a folder will appear when the tab for that
folder is selected from the Object Catalog.

This option is only used if you have added a folder to the Catalog folder while running Crystal 3D IMPACT! or if the Catalog 
folder has been moved. If a folder is added to the Catalog folder prior to starting a Crystal 3D IMPACT! session, the new folder is
automatically assigned a tab in the Object Catalog dialog.

By default, the Catalog folder is located under the Crystal 3D IMPACT! program folder.

 



Locate Note:

The [OK] button is disabled if an invalid Catalog folder has been selected. A valid Catalog folder contains folders that have valid 
catalog objects within them.



Custom Image Hint

Keep in mind that you can use an AVI movie or a series of sequential TGA files as an image for animated textures.



Creating an Animated Background
To create an animated background, follow the steps outlined below:
· Select the RENDER>Set Background command (or click on the Background icon on the 

Toolbar).
· Click on Image: then click on the [Browse…] button. A standard Windows Open dialog box will 

appear.
· Change the Files of Type: to AVI Movie or Targa Sequence.
· Select the desired AVI Movie or Targa Sequence.
· Click the [Open] button.
· Click the [OK] button.
· The first frame of the selected AVI Movie or Targa Sequence will show in the background.
· To see the animated background, select the ANIMATION>Preview command or the 

ANIMATION>Make Movie command



Creating an Animated Texture
Animated textures can only be applied to Image Templates objects from the Object Catalog. To create an animated texture, 
follow the steps outlined below:

· Click and drag the desired Image Templates object into the Working Area.
· A Replace Image dialog box will automatically open.
· Click on the [Browse…] button. A standard Windows Open dialog box will appear.
· Change the Files of Type: to AVI Movie or Targa Sequence.
· Select the desired AVI Movie or Targa Sequence.
· Click the [Open] button.
· Click the [OK] button.
· The first frame of the selected AVI Movie or Targa Sequence will show on the object.
· To see the animated texture, select the ANIMATION>Preview command or the 

ANIMATION>Make Movie command.



Selecting the Correct Object
Sometimes, if you are working on a project with many different objects, it is difficult to select the correct object for editing (i.e., 
applying color, material, bevel, motion, etc). One good way to double check that you have the correct object selected is by 
looking at the color bar under the “A” on the color icon on the toolbar. This color bar changes to the color of the currently 
selected object. Keep in mind that this will not help if all of your objects are the same color.



Upper 1/3 Position

Moves the selection to the upper 1/3rd of the Working Area.



Middle Position

Moves the selection to the vertical middle of the Working Area.



Lower 1/3rd Position

Moves the selection to the lower 1/3rd of the Working Area.



Follow these steps to create dazzling 3D text!



Select a bevel to apply to your text here.



Select a material to apply to your text here.



Select a motion path for your text here.



Enter text for your project here.



Click [Finish] to return to the Working Area. From there you may render your 3D project, save the image or save the animation.



Closes this dialog.



This is your computer ID code.    Use this when registering/purchasing.



After you have registered/purchased, your password will be displayed here.



Closes this dialog and applies a bevel to the selected object(s).



Closes this dialog without applying any bevel to the selected object(s).



Click here to launch the Text Wizard that walks you through the steps for creating dazzling 3D text.



Click here to start a new project on a blank Working Area.



Open an existing 3D Project.



Closes this dialog and applies the selected option.



Closes this dialog without applying the selected option.



Choose an item from the list.



Closes this dialog and saves any changes you have made.



Closes this dialog without saving any changes you have made.



Click this button to make your choice.



Select your preferred option.



Select your preferred option.



Select your preferred option.



Select your preferred option.



Select your preferred option.



Select your preferred option.



Select your preferred option.



Select your preferred option.



Select the amount of zoom to apply to the Working Area.    Note that this function changes only your view of the Working Area, not 
the scale of the objects themselves.



Use the arrows to select your preferred value.



Closes this dialog and saves any changes you have made.



Closes this dialog without saving any changes you have made.



Closes this dialog and saves any changes you have made.



Closes this dialog without saving any changes you have made.



Enter the name of the image file in this field.



Click here to select the location to save the file.



Select the image type.    Available options include TGA, TIFF, BMP, GIF, JPEG, PCX and PNG.



Click this button to select options specific to the image type.



Select the image format.    The formats available depend upon the image type.



Enter the width, in pixels, here.



Enter the width, in pixels, here.



Click here to increase/decrease the width.



Enter the height, in pixels, here.



Enter the height, in pixels, here.



Click here to increase/decrease the height.



Click this button to save your image.



Click this button to delete your image.



Enter the number of colors for the image. Valid entries are 1-256



Enter the number of colors for the image. Valid entries are 1-256.



Use the up arrow to increase the number of colors. Use the down arrow to decrease the number of colors.



Click this button to save your image.



Click this button to delete your image.



Drag the slider to adjust the quality of the image.



Drag the slider to adjust the quality of the image.



This number represents the quality, where 1 is the lowest quality setting and 100 is the highest quality setting.



Click this button to save your image.



Click this button to delete your image.



Click this button to zoom in the image.



Click this button to zoom out the image.



Click this button to show the image at full size.



Click this button to close the window.



Click this button for more help.



Click here for a color background. The default color is white.



Click here for a background image.



This window displays the current color selection.



Click this button to select a different background color.



This window displays the current image selected.



Click this button to select a different background image.



Click here to have the image scaled to fit in the background of the Working Area.



Click here to have the background image tiled across the Working Area.



Closes this dialog and saves any changes you have made.



Closes this dialog without saving any changes you have made.



Enter the name of the movie file in this field.



Click here to select the location to save the file.



Select the movie type here.    Available options include AVIs, Animated GIFs, Autodesk FLCs, and various image sequences.



Click here to open a dialog box for compression options.



Select the format for the movie.    Available options depend upon the current selection in the Type field above.



Select the number of colors for your animation.    This option is only available for 8-bit formats.    If the movie type is Animated GIF, 
you will be asked to choose the number of colors later.



Use the arrows increase/decrease the colors value.



Enter the width, in pixels, here.



Use the arrows to increase/decrease the width.



Enter the height, in pixels, here.



Use the arrows to increase/decrease the height.



The number of seconds an animation will play or the total number of frames for the animation.    Maximum scene length is 100 
seconds or 1,000 frames.



Use the arrows to increase/decrease the scene length.



The number of seconds the final frame of an animation will be displayed after the movie ends.    Maximum pause length is 100 
seconds or 1,000 frames.



Use the arrows to increase/decrease the pause length.



The number of frames played per second. Valid input from 1-72.



Use the arrows to increase/decrease the frame rate.



Closes this dialog and saves any changes you have made.



Closes this dialog without saving any changes you have made.



Click here to save the entire animation to a movie.



Click here to save only part of the animation to a movie.



Enter the time the movie should start from.



Use the arrows to increase/decrease the starting time.



Enter the time the movie should stop at.



Use the arrows to increase/decrease the stopping time.



Select this choice to have your animation follow the forward direction of the motion path.



Select this choice to have your animation follow the reverse direction of the motion path.



Click here to download 3D objects from our web site (you must be online).



Closes this dialog without saving any changes you have made.



Closes this dialog.



Click this button to make your choice.



Click this button to make your choice.



Closes this dialog and saves any changes you have made.



Closes this dialog without saving any changes you have made.



Click here to work in wireframe mode.    This mode uses wireframes to represent the objects in your scene.    This option 
consumes the least amount of memory and is recommended for slower computers.



Click here to work in shaded mode.    This mode uses real time shading to represent the objects in your scene.    This option is the 
default and is recommended for most computers.



This option shades objects while editing them (moving, stretching, scaling, etc).    This option is only recommended for more 
powerful computers.



This options show texture maps on objects while in shaded mode.    Slower computers may perform better with this option off.    
The textures will show up regardless when saving images and movies.



This options shows the background image while in shaded mode.    Slower computers may perform better with this option off.    
The background will show up regardless when saving images and movies.



Indicates whether or not a 3D hardware accelerator compatible with the shading software is present.    A 3D hardware accelerator 
can dramatically improve the performance of the shaded mode.



Indicates which shading software is being used.    Currently, only OpenGL is supported.



Check your desired options.



Select your preferred option.



Select your preferred option.



Select your preferred option.



Select your preferred option.



If an animated texture or background has been assigned (using either a Video for Windows AVI or a Targa sequence), this option 
will animate textures and the background when using the Preview Animation feature.    Slower computers may show a faster 
preview with this option off.    Textures and the background will animate regardless when saving movies.



Closes this dialog.



Enter the width, in pixels, of the working area here.



Click here to increase/decrease the width.



Enter the height, in pixels, of the working area here.



Click here to increase/decrease the height.



Select a standard dimension from the drop down list box.



Closes this dialog and saves any changes you have made.



Closes this dialog without saving any changes you have made.



Closes this dialog and applies selected options.



Closes this dialog without saving options.



Transparent background – makes the background on the BMP disappear so that it appears to float on whatever background 
appears in another project (some applications can take advantage of the transparent background feature of BMPs – consult that 
program's documentation to see if this option is applicable).



Blend edges with current background – Blends the edges of the object(s) with the background. For example, if the object is a 
red sphere and the background is black, close inspection will reveal that some of the pixels where the edge of the sphere touches 
the background will be dark red – a blending of red and black when Blend Edges option is selected. If you plan to do a luminance 
key mix effect with your BMP image over a known background, set the background color of the project in 3D IMPACT! Pro to 
match as closely as possible, select the Transparent background and Blend edges options, and your image will look cleaner 
around the edges when you key it in the video. Also, you can grab a representative frame of video from your production, set it as 
the background in your 3D IMPACT! Pro project, select Transparent Background and Blend the edges (with that background), and
the resulting luminance key should be cleaner around the edges of the image. 



Closes this dialog and applies selected options.



Closes this dialog without applying selected options.



Transparent background -- makes the background on the GIF disappear so that it appears to float on whatever background 
appears on a web page.



Blend edges with current background -- Blends the edges of the object(s) with the background. For example, if the object is a 
red sphere and the background is black, close inspection will reveal that some of the pixels where the edge of the sphere touches 
the background will be dark red -- a blending of red and black when Blend Edges option is selected. Note that the default method 
of saving GIF and PNG files is to have the background -- whether it be a solid color or an image -- transparent. Therefore, if you 
wish to save the objects and the background together, you must select Blend Edges or your saved image will be missing the 
background.



Enter your input in this field.



Use the arrows to select your preferred value.



Select from different catalog object groups here.



Click this button to point to a new location for the 3D Object Catalog if you have moved it from its default location in the Crystal 3D
IPACT! folder or if you have added an additional 3D Object Catalog. Note that this action does not open the Catalog folder; it 
merely tells 3D IMPACT! where it is.



Transparent background -- makes the background on the GIF disappear so that it appears to float on whatever background 
appears on a web page.



Blend edges with current background -- Blends the edges of the object(s) with the background. For example, if the object is a 
red sphere and the background is black, close inspection will reveal that some of the pixels where the edge of the sphere touches 
the background will be dark red -- a blending of red and black when Blend Edges option is selected. Note that the default method 
of saving GIF and PNG files is to have the background -- whether it be a solid color or an image -- transparent. Therefore, if you 
wish to save the objects and the background together, you must select Blend Edges or your saved image will be missing the 
background.



Enter the number of times you want the animation to play.



Use the arrows to select your preferred value.



Closes this dialog and saves any changes you have made.



Closes this dialog without saving any changes you have made.



Type your e-mail address here when you have obtained a password.



Type your password here.    See "How to Register" for more details.



Click this button to find out how to register the product.



Click this button to find out the benefits of registering this product.



Closes this dialog.



Click this button to register the product online.



This is your computer ID code.    Use this when registering.



Click this button to register the product via e-mail, fax or US Mail.



Click here to close this dialog.



Closes this dialog and accepts any options you have selected.



Closes this dialog without saving any options.



Check here to interlace the PNG image for quicker display on a web site.



Check here to save the image with a transparent background.



Check here to opt for smooth edges.



Closes this dialog and applies selected options.



Closes this dialog without applying selected options.



Check this box to apply field rendering to the sequentially rendered images.



This box is enabled only if the "Field Rendering" box is checked. Check this box if you need to reverse the field order of your 
sequentially rendered files.



NTSC Color Correction -- In order to be broadcast or used in a video production, the amount of color (chrominance) and 
brightness (luminance) in an image must fall within a standard range. This option automatically corrects your image so that it 
meets the standards.



Blend edges with current background – Blends the edges of the object(s) with the background. For example, if the object is a 
red sphere and the background is black, close inspection will reveal that some of the pixels where the edge of the sphere touches 
the background will be dark red – a blending of red and black when Blend Edges option is selected. If you plan to do a luminance 
key mix effect with your BMP image over a known background, set the background color of the project in 3D IMPACT! Pro to 
match as closely as possible, select the Transparent background and Blend edges options, and your image will look cleaner 
around the edges when you key it in the video. Also, you can grab a representative frame of video from your production, set it as 
the background in your 3D IMPACT! Pro project, select Transparent Background and Blend the edges (with that background), and
the resulting luminance key should be cleaner around the edges of the image. 



Closes this dialog and applies compression to the TIFF image file if the compression box is checked.



Closes this dialog without saving any changes you have made.



Check here to apply compression to the TIFF image file.



Transparent background -- makes the background on the TIFF disappear so that it appears to float on whatever background 
appears on a web page.



Blend edges with current background -- Blends the edges of the object(s) with the background. For example, if the object is a 
red sphere and the background is black, close inspection will reveal that some of the pixels where the edge of the sphere touches 
the background will be dark red -- a blending of red and black when Blend Edges option is selected. 



Type your e-mail address here when you have obtained a password.



Type your password here.    See "How to Purchase" for more details.



Click this button to find out how to purchase the product.



Click this button to find out the benefits of purchasing this product.



Click this button to exit the program.



Closes this dialog.



Type your e-mail address here when you have obtained a password.



Type your password here.    See "How to Purchase" for more details.



Click this button to find out how to purchase the product.



Click this button to find out the benefits of purchasing this product.



Click this button to make your choice.



Closes this dialog.



Type your e-mail address here when you have obtained a password.



Type your password here.    See "How to Purchase" for more details.



Click this button to find out how to purchase the product.



Click this button to find out the benefits of purchasing this product.



Closes this dialog.



Click this button to find out how to purchase the product.



Click this button to find out the benefits of purchasing this product.



Click here to close this dialog.



Click this button to purchase 3D IMPACT! online.



Click this button to print a purchase form.



Click here to close this dialog.



Closes this dialog and applies the selected image.



Closes this dialog without saving any changes you have made.



Enter your input in this field.



Click this button to make your choice.



Check your desired options.



Closes this dialog and saves any changes you have made.



Closes this dialog without saving any changes you have made.



Choose a type face and font size from the lists, and font styles.



Choose an item from the list.



Select to move your text to the left side of the Working Area.



Select to move your text to the center of the Working Area.



Select to move your text to the right side of the Working Area.



Select to move your text to the upper 1/3rd of the Working Area.



Select to move your text to the middle (vertically) of the Working Area.



Select to move your text to the lower 1/3rd of the Working Area.



Enter your input in this field.



Enter the desired width of the Working Area.



Use the arrows to select your preferred value.



Enter the desired height of the Working Area.



Use the arrows to select your preferred value.



Follow these steps to create 3D text.



Enter your input in this field.



Enter your input in this field.



Select one of these bevels to apply to your text.



Follow these stept to create 3D text.



Choose one of these materials to apply to your text.



Follow these steps to create 3D text.



Select a motion to apply to your text.



Follow these steps to create 3D text.



Follow these steps to create 3D text.



Choose a material to apply to the FRONT face of the text.



Follow these steps to create 3D text.



Choose a material to apply to the SIDE of your text.



Follow these steps to create 3D text.



Choose a material to apply to the BACK of your text.



Follow these steps to create 3D text.



Accept your creation as it is, or back up to change it.



Follow these steps to create 3D text.



Click this button to accept the selected values.



Click this button to decline the selected values.



Closes this dialog without saving any changes you have made.



Closes this dialog and applies the material to the selected object(s).



Closes this dialog without applying any material to the selected object(s).



Closes this dialog and applies a motion to the selected object(s).



Closes this dialog without applying any motion to the selected object(s).



Superblack background -- This option allows you to key your animation over another background while keeping black parts of 
the image visible (using a video editor). This is especially useful if your animated model casts black drop shadows.



Blend edges with current background -- Blends the edges of the object(s) with the background. For example, if the object is a 
red sphere and the background is black, close inspection will reveal that some of the pixels where the edge of the sphere touches 
the background will be dark red -- a blending of red and black when Blend Edges option is selected. For example, if you plan to do
a luminance key mix effect with your animation over a known background, set the background color of the project in 3D IMPACT! 
Pro to match as closely as possible, select the Transparent background and Blend edges options, and your movie will look 
cleaner around the edges when you key it in the video. Also, you can grab a representative frame of video from your production, 
set it as the background in your 3D IMPACT! Pro project, select Superblack Background and Blend the edges (with that 
background), and the resulting luminance key should be cleaner around the edges of the animation. 



NTSC Color Correction -- In order to be broadcast or used in a video production, the amount of color (chrominance) and 
brightness (luminance) in an image must fall within a standard range. This option automatically corrects your image so that it 
meets the standards.



Compression -- Here you will select the compression method to be used for your animation, including which compression 
program (or "codec") to use, the compression quality, data rate and key frame selection. The last two values can be left as-is, 
unless you want to experiment. Compression quality is another matter. These are "lossy" compression programs, so the higher 
the number, the smaller the file size (but the picture quality will suffer). If you have compressed JPEG images, you may find this a 
bit confusing. When compressing a JPEG, 100% compression quality results in a file that is virtually uncompressed. With codec 
compression, however, the opposite is true. 100% compression means the maximum amount of compression possible is used 
during the encoding process, and thus your picture quality will suffer (greatly). Note that the compressors were installed with 
Windows 95/WindowsNTand not with 3D IMPACT! Pro. Therefore, the list of codecs on your computer may be different from the 
list on another machine. Each codec will have its own list of options. Your best bet is to experiment with the settings and see what 
looks best, or contact the supplier of the compression software for technical support. Cinepak by Radius is an excellent codec to 
select (and it probably is installed on your system), and it comes pre-configured so you will not have to choose any options.



Closes this dialog and saves any changes you have made.



Closes this dialog without saving any changes you have made.



Select a Video for Windows compressor.



Click this button to select compression options specific to the selected compressor.



Click here to interleave the movie.    Interleaving can yield better compression, but may have a quality trade-off.



If interleaving the movie, select the how ofter to interleave here.    A higher number can achieve better compression, but usually 
results in lower visual quality.



Additional options specific to the selected compression.



Closes this dialog and saves any changes you have made.



Closes this dialog without saving any changes you have made.



Enter your input in this field.



Click this button to make your choice.



Click this button to make your choice.



Select a compression codec from the drop down list box.



Slide the bar to select the desired compression quality.



Click here to use key frames in the movie.    Using key frames can yield better compression, but may have a quality trade-off.



If using key frames in the movie, select the how often to use them here.    A higher number can achieve better compression, but 
usually results in lower visual quality.



Use this option to tell the compressor to try and limit amount of data stored every second.    This can be useful for restricting the 
size of the final movie.



Select the maximum data rate here, if the Data Rate is checked.



Closes this dialog and saves any changes you have made.



Closes this dialog without saving any changes you have made.



Click this button to open a dialog box to configure the selected compression codec.



Click this button to read more about the selected compression codec.



Click this button to make your choice.




